GRADUATE COUNCIL: NEW COURSE PROPOSAL
Originating Unit: Nursing
Type of action: [_—_] New course Full online course**

Semester and year course will take effect: Fg|| 2025

New course title: |ntro to Acute Care Adult-Gerontology Practicum
Appropriate computer abbreviation (30 spaces or less): |ntro ACAG Pract

Course instructional methodology: Practicum

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: NAPN 85183

Prerequisites for new course: include an attachment if additional space is needed

Prerequisites: NURS 50003; NURS 50013; NAPN 84201; NURS 50053; NAPN 84223 (or concurrent enrollment);
NURS 50022. This course is taken concurrently with NAPN 84213.

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments




Description of new course (catalog copy): include an attachment if additional space is needed

Prerequisites: NURS 50003; NURS 50013; NAPN 84201; NURS 50053; NAPN 84223 (or concurrent enrollment);
NURS 50022. This course is taken concurrently with NAPN 84213, This clinical practicum course
focuses on the acquisition of diagnostic decision-making skills necessary to practice
as a nurse practitioner in an adult-gerontology acute care setting caring for patients
over the continuum of wellness through acute care. Students participate in a direct
patient care supervised practicum in an adult-gerontology care setting with a qualified
preceptor. Application of evidence-based clinical practice guidelines, tools, and
methods for promoting safe, patient-centered care will be emphasized.

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

see attached file

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: none
Space: none
Equipment: none
Library: none
Financial Aid: none
Other: none

Change in teaching load: none

Does this change affect any other units of the University? D Yes No
If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Suzy Lockwood

Unit: Nursing-Grad

. ! Digitally signed by Dr Suzy Lockwood
Signature:
ignature: [ ) SUZy Lockwood Date: 2022.09.09 13:08:00 -05'00"



This syllabus represents my current plans and objectives. As we go through the
semester, those plans may need to change to enhance the class learning opportunity.
Such changes, communicated clearly, are not unusual and should be expected.

NAPN 85183 Intro to Acute Care Practicum

Instructor Name:

Semester and Year:

Number of Credits: 3

Class Location: Online

Class Meeting Day(s) & Time(s): Asynchronous

Office Location:

Office Hours: [If you will use virtual office hours, indicate this and instruct students how to access.]
Telephone:

Email:

Response Time: [If a student has contacted you with a question or a concern, how soon do you
reply to these queries? Does this differ on weekends / holidays?]

Final Exam Date & Other Important Dates

There is no final examination in this course. There will be a final clinical site assessment
scheduled with you and your preceptor. This course is graded on a Pass/No Credit basis.

Course Description

This course is taken concurrently with NAPN 84213. This clinical practicum course focuses on the
acquisition of diagnostic decision-making skills necessary to practice as a nurse practitioner in an
adult-gerontology acute care setting caring for patients over the continuum of wellness through
acute care. Students participate in a direct patient care supervised practicum in an adult-gerontology
care setting with a qualified preceptor. Application of evidence-based clinical practice guidelines,
tools, and methods for promoting safe, patient-centered care will be emphasized.

Learning Outcomes

Upon completion of this course the student should be able to:

1. Perform comprehensive and problem specific health assessments in the acute
care setting for the adult/gerontology patient population.

2. Formulate differential diagnoses based on health assessment.

3. Employ appropriate screening and diagnostic tools with consideration for costs,
risks, and benefits.

4. Develop appropriate evidence-based treatment plans for common acute and
chronic conditions including pharmacologic and nonpharmacologic therapies.

5. Evaluate treatment plans for effectiveness.

Incorporate health care technologies into clinical practice.

7. Collaborate with members of the health care team and community agencies in an
interprofessional approach to facilitate quality care.

o



Prerequisites

Prerequisites: NURS 50003; NURS 50013; NAPN 84202; NURS 50053; NAPN 84223 (or
concurrent enroliment); NURS 50022. This course is taken concurrently with NAPN 84213.

This course meets the following DNP Essentials and TCU DNP Program Outcomes, and
NONPF Competencies:

Assignment DNP TCU DNP 2022 NONPF Course
Essential | Program Competencies A Outcomes

Outcomes

Self- [, 11, I, 1,2,3,6 d Pracltice 35

Assessment (3) VI, VIII Inquiry (1-
4,6)

¢ Technology &
Information
Literacy (1-
5)

* Policy -

* Health
Delivery
System
(1,3,5-7)

* Ethics -

* Independent
Practice (2-

o 7)

Threaded LNV, 1,2,3,5 * Scientific 1-5

Discussions (6) VI, VIII ZOZ?dationS

* Leadership
(1-6)

* Quality (1-
3,5)

* Practice
Inquiry (1-6)

* Technology &
Information
Literacy
(2,3,5)

e Policy (1-3,
5-7)

* Health
Delivery
System (3-
7)

e Ethics (1-3)

* Independent



http://tcu.smartcatalogiq.com/Current/Graduate-Catalog/Courses/NURS-Nursing/50000/NURS-50003
http://tcu.smartcatalogiq.com/Current/Graduate-Catalog/Courses/NURS-Nursing/50000/NURS-50013
http://tcu.smartcatalogiq.com/Current/Graduate-Catalog/Courses/NURS-Nursing/50000/NURS-50053
http://tcu.smartcatalogiq.com/Current/Graduate-Catalog/Courses/NURS-Nursing/50000/NURS-50022
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Ethics (1-3)
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Required Texts / Materials

The same textbook requirements for the didactic portion will apply to the Practicum course:

REQUIRED

Buttaro, T.M., Trybulski, J., Bailey, P. P., & Sandberg
Cook, J. (2020). Primary
PRIMARY CARE care: Interprofessional collaborative practice,

INTERPROFESSIONAL COLLABORATIVE PRACTICE

e (6th Ed.). St. Louis: Mosby.
ISBN-10: 0323570151, eText available

Joanne Sandberg-Cook

REQUIRED

Advanced

sl Dains, J.E., Baumann, L.C., & Scheibel, P. (2019).

n Primary Care

Advanced health assessment & clinical diagnosis in
primary care, (6th Ed). St. Louis: Mosby.

ISBN 10: 0323554962, eText available




Fischbach’s

A Manual of

LABORATORY o
Anp DIAGNOSTIC

TESTS

Tenth

Edition .
> Frances Talaska Fischbach

Margaret A. Fischbach

REQUIRED

Fischbach, F., Dunning, M.B. (2017). A manual of

Laboratory and Diagnostic Tests (1 oth Ed.).
Philadelphia, PA: Lippincott Williams & Wilkins

ISBN: 9781496377128

Bl

* THE SANFORD GUIDE
Tharag

o T Kevimsacrobisl apy

REQUIRED
Gilbert, D. N., Moellering, R. C., Eliopoulos, G. M.,
Chambers, H. F. & Saag, M. S.
(2018). Sanford Guide to Antimicrobial Therapy.
(50th Ed.). Sperryville, VA, Antimicrobial Therapy
Inc.

Pocket edition, Spiral edition, Library edition, and
smartphone App Available.

(always get the latest version as it is updated
annually)

ISBN: 978-1-944272-13-5

Geriatric

Eighth Edition

REQUIRED

Kane, R. L., Ouslander, J. G., Resnick, B., & Malone,

R. L. (2018). Essentials of Clinical Geriatrics, (8th
Ed.). New York: McGraw-Hill Education.

ISBN-13: 978-1259860515

FITZPATRICK'S
COLOR ATLAS AND SYNOPSIS OF

CLINICAL
DERMATOLOGY

REQUIRED
Wolff, K., Johnson, R. A., & Surmond, D. (2017).
Fitzpatrick’s Color Atlas & Synopsis of Clinical

Dermatology (8th Ed.). New York: McGraw-Hill
Education

ISBN-13: 978-1259642197, eText available. App
Available.




REQUIRED

American Psychological Association. (2020).
Publication manual of the American Psychological

Mgﬁ:ﬁ‘gl Association, (7th Ed.).

Washington: Author

ISBN-10: 143383216X ISBN-13:
978-1433832161

REQUIRED

ASCVD Risk Estimator by American College of
Cardiology:http://www.acc.org/tools-and- practice-
support/mobile- resources/features/2013-prevention-
guidelines- ascvd-risk-estimator

App Available, free.

REQUIRED

ePSS (Electronic Preventive Services Selector) by
Agency for Healthcare Research and
Quality:http://epss.ahrq.gov/PDA/index.jsp

App Available, free.

RECOMMENDED
Epocrates: www.epocrates.com App Available.

Y 2y epocrates”-+

Teaching Philosophy

[In this brief statement, include descriptions of how you think learning occurs, how students should
participate in the learning process, and how you understand your role in the course.]


http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://www.acc.org/tools-and-practice-support/mobile-resources/features/2013-prevention-guidelines-ascvd-risk-estimator
http://epss.ahrq.gov/PDA/index.jsp
http://www.epocrates.com/

Instructional Methods

This supervised practicum course will include a minimum of 180 direct patient care clinical
hours. In addition, students will participate in threaded discussions, objectives & self-
assessment assignment, and documentation of clinical logs.

The practicum is graded on a Pass/No Credit basis.

Course Policies and Requirements
Assignments
CLINICAL CASE LOGS

1. Documentation of clinical encounters through the Typhon Group Patient Tracking
Program permits the faculty to evaluate student progress during the clinical
practicum experience. The documentation of clinical encounters becomes part of
the student’s permanent file and substantiates the Director's recommendation for
certification upon graduation. Students are expected to submit clinical encounters
and clinical hours to the web-based clinical tracking system. The web-based
program can be accessed at: http://www.typhongroup.net. Data must be entered
weekly (See Course Schedule/Assignments/Due Dates). Faculty feedback and
approval on log entries will take place within Typhon web-based system. If
students experience technical issues related to the Typhon system, they should
contact Typhon technical support directly.

2. Toreceive full credit, the student must demonstrate completion of the minimum
required direct patient care clinical hours (180 clock hours) by completing and
submitting:

a. Signed clinical attendance time log (submitted through TCU online).
b. Clinical patient case logs (Must submit hours weekly (daily is best) and be
approved by faculty.


http://www.typhongroup.net/

c. Clinical logs must be timely and accurate for full approval for credit.

Submission of 3 SOAP notes via TCU online scattered throughout the

semester. You may be required to submit additional SOAP notes
depending upon your progress.

Clinical Case Logs fulfill course-learning outcomes 1-5 and 7.

THREADED DISCUSSIONS (6)

There will be 6 Threaded Discussion scattered throughout the semester. Each student is
expected to post one original response by Wednesday and respond to at least three other
student’s post by Friday to receive full credit (more responses are encouraged). Threaded
Discussions are a wonderful way to share information and promote learning among

professional colleagues. The focus of discussions will center on clinical pearls, incorporation of

technology and EBP clinical tools. To receive passing credit, the student must score a
cumulative grade of >80% on the threaded discussions.

Threaded discussions fulfill course learning outcomes 3,4,6

Threaded Discussion Rubric

CATEGORY
3 2 1 0

Topic Response |Respondingto the |Responding to the|Responding to the |Not responding
instructor's topic by [instructor's topiclinstructor's topic [to the
Wednesday. by Friday. by Sunday. instructor's

topic.

Peer Response |Responding to at Responding to Responding to Responding to
least 3 peers 3 peers 3 peers NO peer
posting by Friday.  |posting by posting by postings.

Saturday. Sunday.
Final Response |Respondingto all Responding to Responding to Responding to

to the discussion by
suggesting other
solutions, pointing
out problems, or
even respectfully

disagreeing.

add moderately to
the discussion by
suggesting other
solutions, pointing
out problems, or

even respectfully

not add to the
discussion.
Student does not
substantiate any
comments made
with reasoning or

peers who have 3/4 of the peers |1/2 of the peers |NONE of the
posted a response tojwho have posted |who have posted |peers who have
you. a response to a response to posted a
you. you. response to
you.
Quality Threads |Student comments  |Student Student Student does
that add significantly Jcomments that comments that do

not participate at
all in the
threaded
discussion.




Student also disagreeing. even source

substantiates any Student does not |[citation.
substantiate any  |Posting is simple:

cgmments made comments made "l agree” or "Yes"

with reasoning or  |with reasoning or Nor

even source citation. |even source or "No

A quality posting is  [citation.

about 30 to 75 Posting is about

words. 20 to 75 words.

Learning Objectives and Self-Assessment Assignments (3)

The purpose of this 3-part assignment is to guide the clinical experience and your professional
development as a nurse practitioner student (See Course Schedule/Assignments/Due Dates).
The clinical experience is directed by the development, reevaluation, and reflection of your
clinical objectives. Your clinical faculty and your preceptor will both review and discuss this
assignment with you during your semester.

Grading Rubrics for the 3 assignments are in the course shell. Students will be required to score:
>24 points on Part 1, >16 points on Part 2, and >40 points on Part 3 to successfully receive
credit.

Objectives and Self-Assessments fulfill course-learning outcomes 3,4,6,7.

Clinical Performance

To be successful and receive CREDIT for this course the student must:

1. Demonstrate completion of the minimum required direct patient care clinical
hours (180 clock hours) by completing and submitting:

a. Signed clinical attendance time log.

b. Clinical patient case logs (submitted through Typhon patient tracking
system. Must submit hours weekly and approved by faculty).

c. Submission of 3 SOAP notes via Typhon scattered throughout the
semester. Your Clinical Faculty Advisor may require additional SOAP
notes depending upon your progress.

2. Receive satisfactory evaluations from preceptor submitted through Typhon
evaluation system (see course shell for evaluation forms).

3. Receive satisfactory evaluations from faculty submitted through Typhon
evaluation system (must receive evaluation score >30 to receive passing credit;
see course shell for evaluation forms).

4. Demonstrate completion of all assigned practicum learning activities (Threaded
Discussions and Learning Objectives & Self-Assessment Assignment).

5. Demonstrate completion of end of semester evaluation of clinical site and
preceptor (see course shell for evaluations).



Grading

Final Grade Elements / Grade Breakdown:

Outcome(s) | Assignments, Exams/Quizzes, Presentations, etc. Percentage

Clinical Typhon patient case logs Pass/No
Credit (see
criteria
below)

DFWHC Quiz 10%

Learning Objectives & Self- Assessment 30%

Assignment

Threaded discussion 30%

SOAP Notes (3) 30%

There are no options for extra credit.

Progression to NAPN 85213 Acute Care Adult-Gerontology | and NAPN 85283 Acute Care Adult-
Gerontology | Practicum requires achievement of a grade of 80% or higher in NAPN 84213
Primary Care Adult Gerontology | and a PASSING grade in NAPN 851833 Intro to Acute
Care Practicum.

Grading Scales

Grading for this course will be Pass or No Credit. Elements reviewed by faculty to make
this determination include aspects of the Preceptor evaluation of student performance,
Faculty evaluation of student performance, Typhon case logs entries, student
engagement within the shell with other students, and communication with faculty.
Additionally, quality of Threaded Discussion content and Learning Objectives & Self-
Assessment assignment will receive a grade as part of the determination of course
success. For activities receiving a numerical grade in the practicum, a grade of 80% or
more is considered passing. The faculty is the final evaluator of the student and will
assign the final Pass or No Credit grade.

Late Work

No late work is accepted. Please contact me as soon as possible if you are
concerned.

Remote Testing Protocol

This course requires the use of LockDown Browser and a webcam for online exams and
quizzes. Here is information for LockDown Browser and webcam.
https://cte.tcu.edu/edtech/respondus/ . Students will also be required to read the Exam
Monitor Remote Testing Protocol https://harriscollege.tcu.edu/nursing/wp-
content/uploads/sites/6/2020/07/Graduate-Remote-Testing-Protocol.docx and sign the
Student Acknowledgment Form at the beginning of the semester. This form is added to
your course modules as an assignment. Please upload after signing.



https://cte.tcu.edu/edtech/respondus/
https://harriscollege.tcu.edu/nursing/wp-content/uploads/sites/6/2020/07/Graduate-Remote-Testing-Protocol.docx
https://harriscollege.tcu.edu/nursing/wp-content/uploads/sites/6/2020/07/Graduate-Remote-Testing-Protocol.docx

Grading Concerns

Type your policy regarding questions about grades.

[Clearly articulate what you would like students to do if they have a question about a grade or your
feedback. Is there a time-frame for addressing these issues? With whom should they speak first or
second? Do you require a written statement? What should this statement contain? Refer to the
relevant sections of the Student Handbook for further information.]

Participation / Engagement (Attendance)

Throughout the semester, the student is expected to work collaboratively with the faculty
and preceptor to schedule individualized clinical experiences to meet the minimum
requirement of 150 clinical hours. These hours must be completed within the timeframe
of the course’s semester. A log documenting the clinical hours and verified by the
original signature of the Preceptor will be submitted at the end of course validating
completion of these hours. The student is expected to remain engaged in the course
shell and to communicate regularly with the faculty.

Every other day review of the Syllabus and Course Schedule are essential to have an
awareness of course expectations, learning outcomes, assignments, due dates, and
grading policies.

Communication between the student and instructor must occur through TCU email. Itis
the student’s responsibility to check his/her email at least every other day for any
communication from the instructor.

Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email messages,
discussions, and chats. If | deem any of them to be inappropriate or offensive, | will forward the
message to the Chair of the department and appropriate action will be taken, not excluding
expulsion from the course. The same rules apply online as they do in person. Be respectful of other
students. Foul discourse will not be tolerated. Please take a moment and read the basic information
about netiquette (http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites sometimes
used for educational collaborations, should be done with honor and integrity. Please review the
relevant sections of the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/) for
TCU’s network and computing policies and communication guidelines.

Technology Policies

Email

Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Typhon Group Patient Tracking Program


https://deanofstudents.tcu.edu/student-handbook/
http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/

Documentation of clinical encounters through the Typhon Group Patient Tracking Program
permits the faculty to evaluate student progress during the clinical practicum experience. The
documentation of clinical encounters becomes part of the student’s permanent file and
substantiates the Director’s recommendation for certification upon graduation. Students are
expected to submit clinical encounters and clinical hours to the web-based clinical tracking
system. The web-based program can be accessed at: http://www.typhongroup.net. Data must
be entered weekly and approved by faculty (See Course Schedule/Assignments/Due Dates).
Faculty feedback and approval on log entries will take place within Typhon web-based system. If
students experience technical issues related to the Typhon system, they should contact Typhon
technical support directly.

Course Materials

TCU students are prohibited from sharing any portion of course materials (including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without written
permission by the course instructor. Accessing, copying, transporting (to another person or
location), modifying, or destroying programs, records, or data belonging to TCU or another user
without authorization, whether such data is in transit or storage, is prohibited. The full policy can be
found at: https://tcu.policytech.com/dotNet/documents/?docid=55&public=true.

Violating this policy is considered a violation of Section 3.2.8 of the Student Code of Conduct found
in the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/), and may also
constitute Academic Misconduct or Disruptive Classroom Behavior. TCU

encourages student debate and discourse; accordingly, TCU generally interprets and applies its
policies, including the policies referenced above, consistent with the values of free expression and
First Amendment principles.

Recording of Class Sessions

Any synchronous class sessions will all be recorded for use by enrolled students, including those
who are unable to attend live. Students who participate with their camera engaged or utilize a profile
image are consenting to have their video or image recorded. If you do not wish to consent to have
your profile or video image recorded, be sure to keep your camera off and do not use a profile
image. Likewise, students who un-mute during class and participate orally are consenting to have
their voices recorded. If you do not wish to consent to have your voice recorded during class, you
will need to keep your mute button activated and communicate exclusively using the "chat" feature,
which allows students to type questions and comments live. Further, if you anticipate that you will
not consent to your video and/or audio participation being recorded, please contact me immediately
so | may work with you to determine how to assess your class participation and assignments that
may require collaboration during the class session.

Academic Misconduct

Academic Misconduct (Section 3.4 of the Student Code of Conduct found in the Student Handbook
(https://deanofstudents.tcu.edu/student-handbook/)): Any act that violates the academic integrity of
the institution is considered academic misconduct. The definitions and procedures used to resolve
suspected acts of academic misconduct are available in the offices of the Academic Deans and
Dean of Students, and are also listed in detail in the Graduate Catalog
(http://tcu.smartcatalogig.com/en/current/Graduate-Catalog/Academic-Conduct).

Specific examples include, but are not limited to:


http://www.typhongroup.net/
https://tcu.policytech.com/dotNet/documents/?docid=55&public=true
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct
http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct

o Cheating: Copying from another student’s test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices not
authorized by the person in charge of the test; collaborating with or seeking aid from another
student during a test or laboratory without permission; knowingly using, buying, selling, stealing,
transporting, or soliciting in its entirety or in part, the contents of a test or other assignment
unauthorized for release; substituting for another student or permitting another student to
substitute for oneself.

o Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s work, and
the unacknowledged submission or incorporation of that work as one’s own offered for credit.
Appropriation includes the quoting or paraphrasing of another's work without giving proper
credit.

e Collusion: The unauthorized collaboration with another in preparing work offered for credit.

o Abuse of resource materials: Mutilating, destroying, concealing, or stealing such material.

e Computer misuse: Unauthorized or illegal use of computer software or hardware through the
TCU Computer Center or through any programs, terminals, or freestanding computers owned,
leased or operated by TCU or any of its academic units for the purpose of affecting the
academic standing of a student.

o Fabrication and falsification: Unauthorized alteration or invention of any information or citation
in an academic exercise. Falsification involves altering information for use in any academic
exercise. Fabrication involves inventing or counterfeiting information for use in any academic
exercise.

e Multiple submission: The submission by the same individual of substantial portions of the
same academic work (including oral reports) for credit more than once in the same or another
class without authorization.

o Complicity in academic misconduct: Helping another to commit an act of academic
misconduct.

o Bearing false witness: Knowingly and falsely accusing another student of academic
misconduct.

TCU Online: Our Learning Management System

Getting Started with TCU Online

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)
Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online
Option 2: Login at http://d2l.tcu.edu

*For information about logging into TCU Online, view these instructions.
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online Student
Orientation Tutorial, please do so now. To access it, click on the Orientations semester OR view all
courses in your My Courses widget visible upon logging in to TCU Online. Click on the "Student
Orientation Tutorial” to enter the orientation course. Follow the instructions in the course. You can
return to this tutorial at any time.



https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
http://my.tcu.edu/
http://d2l.tcu.edu/
http://tcuonline.tcu.edu/kb/how-do-i-log-in/
http://tcuonline.tcu.edu/kb/how-do-i-log-in/

How This Course Will Use TCU Online

[Per the University Policy for Distance Learning, all online courses must use TCU Online. Tell
students how you plan to use TCU Online in this course: will you post grades, lecture notes, or
assignments? Will students be required to submit items or engage in discussions online?]

Getting Help with TCU Online

If you experience any technical problems while using TCU Online, please do not hesitate to contact
the TCU Online (D2L) Help Desk. They can be reached by phone or chat 24 hours a day, 7 days a
week, 365 days a year.

Phone: 1-877-325-7778
Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the Help Desk to resolve a technical issue, make sure to keep me updated
on the troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you will
login to TCU Online and select your name on the top right of the screen. In the Profile area, you can
upload a photo of yourself and add personal information. In the Notifications area, you can add your
phone number to receive text messages when grades are given as well as reminder texts for
upcoming assignments and quizzes.

Student Success Tools for TCU Online
Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will display
busy times for class work in the upcoming week. You can use this app to manage your daily
workload, and it includes the ability to view and access course materials offline. You can download
Pulse from the Google Play or Apple Store. You can learn more and download Pulse here:
https://www.d2l.com/products/pulse/.

ReadSpeaker

ReadSpeaker includes a number of tools that can enhance your understanding and comprehension
of course materials. ReadSpeaker can create an audio version of content that you can listen to while
on a page within a course or that you can download to listen offline. ReadSpeaker can also read
Microsoft Office files and PDFs. There are additional tools and features to assist you with reading
and focusing in TCU Online, tools that provide support for writing and proofing text, and tools that
can read non-TCU Online content aloud. You can learn more about how to use ReadSpeaker tools
here: https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-
mobile/readspeaker/



http://cte.tcu.edu/wp-content/uploads/University-Policy-for-Distance-Learning-and-Web-Enhanced-Courses_April2018.pdf
https://www.d2l.com/products/pulse/
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Support for TCU Students

Campus Offices
e Academic Advising (817-257-7486, Jarvis 104)

e Brown-Lupton Health Center (817-257-7938 or 817-257-7940)

e Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
e Center for Writing (817-257-7221, Reed Hall 419)

e Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2" floor)

e Dean of Students (817-257-7926, the Harrison 1600)

e Mary Couts Burnett Library: Reference Desk (817-257-7117)

e Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1%t floor)

e Student Access & Accommodations (817-257-6567, The Harrison 1200)
e Student Success (817-257-8345, Samuelson Hall, West Entrance)

e Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2" floor)
e Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
e Veterans Services (817-257-5551, Jarvis Hall 2" floor)

Anti-Discrimination and Title IX Information
Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from
unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this
commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and
retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and
harassment and related sexual and other misconduct based on age, race, color, religion, sex, sexual
orientation, gender, gender identity, gender expression, national origin, ethnic origin, disability,
predisposing genetic information, covered veteran status, and any other basis protected by law. The
Office of Institutional Equity (OIE) is responsible for responding to all reports of discrimination,
harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment,
Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of
Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The Harrison,
Suite 1800 or click here: Make a Report.

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click
here: https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU's Title IX
Coordinator. You may call 817-257-8228 to make a report, email cie@tcu.edu or a.vircks@tcu.edu,



https://tcu.policytech.com/dotNet/documents/?docid=135&public=true
https://tcu.policytech.com/dotNet/documents/?docid=135&public=true
https://tcu.policytech.com/dotNet/documents/?docid=140&public=true
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or make a report here. Additional Title IX resources and information are available at
https://www.tcu.edu/institutional-equity/title-ix/index.php.

Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters. Mandatory
reporters are required to immediately report to OIE any conduct that raises Discrimination,
Harassment, Sexual Misconduct (Title IX or Violence Against Women (VAWA)) or Retaliation.
Mandatory reporters cannot promise to refrain from forwarding the information to OIE.

Confidential On-Campus Resources
Campus Advocacy, Resources & Education
https://care.tcu.edu/ | 817-257-5225

Counseling & Mental Health Center
www.counseling.tcu.edu | 817-257-7863

Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On Campus Resources
TCU Police
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university
required activity because of the religious observance of a holy day shall be provided with a
reasonable opportunity to make up the examination or assignment, without penalty, provided that it
does not create an unreasonable burden on the University.” For more information, please visit the
TCU Policy for Religious Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in
accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. To be
eligible for disability-related academic accommodations, students are required to register with the
TCU Office of Student Access and Accommodation and have their requested accommodations
evaluated. If approved for accommodations, students are required to discuss their official TCU
Notification of Accommodation with their instructors. Accommodations are not retroactive and
require advance notice to implement. The Office of Student Access and Accommodation is located
in The Harrison, Suite 1200. More information on how to apply for accommodations can be found at


https://www.tcu.edu/institutional-equity/make-a-report.php
https://www.tcu.edu/institutional-equity/title-ix/index.php
https://care.tcu.edu/
http://www.counseling.tcu.edu/
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http://www.police.tcu.edu/
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https://www.tcu.edu/access-accommodation/ or by calling Student Access and Accommodation at
(817) 257-6567.

Audio Recording Notification:

Audio recordings of class lectures may be permitted by the instructor or as an approved disability
accommodation through Student Access and Accommodation. Recordings are not to be shared with
other students, posted to any online forum, or otherwise disseminated.

Emergency Response Information

View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek
Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

View the TCU Building Safety Maps that show the specific seek shelter locations and building rally
points for evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)

View the TCU Evacuation Rally Point Map to see all rally points for evacuation.
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)

Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/).

In the event of an emergency, call the TCU Police Department at 817-257-7777.


https://www.tcu.edu/access-accommodation/
https://publicsafety.tcu.edu/less-is-more/
https://publicsafety.tcu.edu/less-is-more/
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Course Schedule

This calendar represents my current plans and objectives. As we go through the semester, those
plans may need to change to enhance the class learning opportunities. Such changes will be clearly
communicated.

DUE
DATE TOPIC READINGS/ASSIGNMENTS DATES
Weeks Module 1 Readings: Refer to didactic
1-2 Module 2 course Midnight
01/10 - Threaded Discussion #1 01/19 —
01/23 %eigr%MQ& A Oral Presentation 1/23
and Clinical DFWHC Foundation Midnight
Paperwork Orientation Quiz 01/23
gﬁiﬁ'ggig 934 Assignment #1: Learning Midnight
Objectives Part 1 01/23
Week 3 | Module 3: Readings: Refer to didactic
01/24 — course
01/30 Practicum Hours/Typhon Midni
. ght
Patient Case Logs 01/30
Week4 | Module 4 Readings: Refer to didactic
01/31 - course Midnight
02/06 Practicum Hours/Typhon 02/06
Patient Case Logs Midnight
Threaded Discussion #2 02/06
Week 5 | Module 5 Readings: Refer to didactic
course Midnight
02/7 — SOAP Note #1 Due 2/13
02/13 Midnight
Practicum Hours/Typhon 02/13
Patient Case Logs




Week 6 | Module 6 Readings: Refer to didactic
02/14 — course
02/20 Practicum Hours/Typhon I
Patient Case Logs I(\)/I2|</12n(|)ght
Threaded Discussion #3 Midnight
02/20
Week7 | Module 7 MIDTERM CHECK IN
02/21 — SURVEY
02/27 Readings: Refer to didactic
course
Practicum Hours/Typhon Midnight
Patient Case Logs 02/27
Week8 | Module 8 Readings: Refer to didactic
02/28 — | ZOOM Meeting: | “0Urs® All Due
03/06 Attendance is Practicum Hours/Patient Midnight
Required Case Logs 03/06
March 2, 2022 Midterm Preceptor
@6:30pm CT Evaluation Midnight
Meeting ID: 975 | Mid Term Typhon log 03/06
9456 1124 Analysis due
Assignment #2: Oral
Presentation Mid-Term
Assessment Part 2 —
completed during Zoom
Week 9 | Spring Break No work due
03-/07-
03/13
Week 10 | Module 10 Threaded Discussion #4 Midnight
03/14 - Practicum Hours/Patient 03/20
03/20 Case Logs Midnight

03/20




Week 11 | Module 11 Readings: Refer to didactic

03/21 — course

03/27 SOAP Note #2 Due Midnight
Practicum Hours/Typhon 03/27
Patient Case Logs Midnight
Practicum Hours/Typhon 03/27
Patient Case Logs

Weeks Module 12 Readings:

12 Refer to didactic course Midnight

03/28 — Threaded Discussion #5 04/03

04/3 Midnight
Practicum Hours/Typhon 04/039
Patient Case Logs

Week 13 | Module 13 Readings:

82;?0' Refer to didactic course Midnight
SOAP Note #3 Due 04710
Practicum Hours/Typhon Midnight
Patient Case Logs 04/10

Week 14 | Module 14 Readings: Refer to didactic

04/11 — | Good Friday: course

04/17 April 15, 2022 Threaded Discussion #6 Midnight
End of Course Clinical 04/17
Evaluation: Schedule with
faculty
Practicum Hours/Patient
Case Logs

Week 15 | Module 15 Readings: Refer to didactic

04/18— course

04/24 End of Course Clinical
Evaluation: Schedule with
faculty
Practicum Hours/Patient Midnight
Case Logs. 04/24

Complete clinical hours this
week.




Week 16 | Module 16 Assignment #3: Self- Midnight
04/25 — Assessment Part 3 05/01
05/01 Final Typhon Analysis due
Complete & Submit Clinical Midnight
Evaluations (Preceptor 05/01
Evaluation of Student;
Student Evaluation of
Preceptor; Student
Evaluation of Clinical
Agenc
) .y) . Midnight
Submit Clinical Attendance 05/01
Roster(s)
Final Final Week SPOT Evaluation
Week End of Course Survey Midnight
05/02 — 05/06

05/06




Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking to complete your SPOT for this
course. | appreciate your thoughtful and reflective feedback to help make this course successful
for future students. You can fill out the SPOT by clicking on the link in the email or in TCU
Online when SPOTs open.

[Explain here how you use SPOT feedback to improve the course over time. You should also
add a note on a module introduction page toward the end of the course to remind students to
complete the SPOT.]

TCU Mission Statement

To educate individuals to think and act as ethical leaders and responsible citizens in the global
community.

[Consider adding the college / program / department mission statement as well.]
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KOEHLER CENTER

For Instruction, Innovation & Engagement

September 9, 2022

To: TCU Graduate Council

SUBJECT: LETTER OF ENDORSEMENT

This is to confirm that the Koehler Center for Instruction, Innovation, and Engagement is
working in collaboration with the Doctor of Nursing Practice Program in the development of a
new fully online course. Accordingly, we have reviewed the proposed syllabus for the courses
listed below:

Course Course Title
Number

NAPN 85183 Intro to Acute Care Practicum

We recommend approval of the above course.

The program has been provided with an annotated syllabus with recommendations from the
Koehler Center. Overall, the syllabus and the eventual course development should ensure: use
of the most recent TCU syllabus template for online instruction; verification that courses run for
the duration of the designated session; sufficient self-assessment opportunities; and well-
defined and clearly communicated policies addressing late work and collaboration / academic
integrity issues regarding quizzes.

The Koehler Center will work individually with the designated instructor to revise the syllabus
and fully develop course content in TCU’s Learning Management System (TCU Online). The
Completed course will need to meet the TCU Policy for Distance Learning and Web-Enhanced
Courses; adhere to federal financial aid, SACS, and state authorization (SARA) regulations; and
implement evidence-based practices in online learning design and delivery as reflected in TCU’s
Online Structure Assessment Tool (OSAT).

The following steps must take place prior to the course going live for online instruction:

TCU Box 298970, Fort Worth, Texas, 76129
cte.tcu.edu



TCU

KOEHLER CENTER

For Instruction, Innovation & Engagement
1. Address the identified syllabus recommendations.
2. Course development in TCU’s Learning Management System, completed at least one
month prior to the first day of the session for each course offering.
Pre-instruction OSAT review & partner with instructor.
4. Review of course shell for implementation of identified high-priority OSAT
improvements.

w

Program leadership should also ensure compliance with provisions related to distance
education. In particular, the instructor of the course must complete Preparing to Teach Online
and TCU Online Boot Camp in advance of the semester in which the course will be taught.

Additionally, if the course is part of a program that is preparation for a new professional license
for out-of-state students, the program must make all reasonable efforts to communicate with
licensure authorities in each student’s state of residence to determine whether the program
fulfills the educational requirements for licensure in the state. These out-of-state students must
be apprised of this information in writing; this information should also be posted on the
program’s website.

Regards,
FAfsaneh Ueanpour-cfarhadi
Dr. A. Farhadi

Director, Online and Distance Learning
Koehler Center for Instruction, Innovation, and Engagement

TCU Box 298970, Fort Worth, Texas, 76129
cte.tcu.edu
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